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FUNcube-1 Dashboard 
Installation and operating guidance notes 

 

Release 1.0  - Nov 13th 2013  

 

Overview 

The FUNcube-1 Dashboard user interface enables the display of telemetry, debug data and Fitter 

messages from the FUNcube-1 (FC1) spacecraft. It can also upload the received data to the FUNcube 

Data Warehouse over the internet. 

The Dashboard can accept live inputs from a directly connected FUNcube Dongle (both Pro and Pro+ 

models) or by audio from another SSB radio fed into the computer soundcard. It can also display 

previously recorded data from IQ “WAV” files or from the “.funcubebin” recordings that it can create 

during operation.  

A   slightly different version of this Dashboard is being developed to provide very similar functionality 

for the FUNcube-2 (FC2) sub-system on the UKube-1 spacecraft which is now expected to launch in 

April 2014. 

The Dashboard has been tested on a variety of different “Windows” machines, from XP through to 

W8. It is not yet available for other operating systems (see the FAQs at the end) 

This version 798 of the software is being made available pre-launch so that users can set up their 

equipment and also establish the links to the FUNcube Data Warehouse. We have also made 

available links to four IQ wav files produced using SDR#, and a .funcubebin file. All of these sources 

can be used to populate the Dashboard display. All of the recordings are from the Engineering 

Model.  Not all the sensor channels were implemented on the EM so don’t be surprised by some odd 

data values. They are all present and correct on the Flight Model! 

The FUNcube concept is that the spacecraft should operate in educational mode (high power 

telemetry downlink only) when in sunlight and amateur mode (low power telemetry and 

transponder) when in eclipse. It is intended that the available data from all of the 50+ telemetry 

channels can be used by schools and colleges to demonstrate a wide variety of science in an 

interesting and challenging manner.  

Finally – a respectful request – please read ALL of these notes before diving in and trying to install, 

configure and use the Dashboard. Please note that the authors have assumed that early users will 

already have experience of using a FUNcube Dongle or of using an SSB VHF receiver! 
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Pre-Requisites 

Prior to updating your station with the capability to receive the FUNcube telemetry, please take a 

moment to ensure that you register at the FUNcube Data Warehouse at 

http://warehouse.funcube.org.uk  

When you have completed registration, you will be emailed with your login details which consists of  

 “Site Id” which is typically your callsign,  

 “Auth Code” which is a unique code used to secure your uploaded data to the warehouse,  

and  

 “URL” which is http://data.funcube.org.uk   

 Please save this data for entry into the Dashboard software.  

We also have a support forum at http://forum.funcube.org.uk for details and support type 

questions.  Again, we encourage you to join the forum and to share your experiences of the 

Dashboard. 

 

Software Installation 

The software is distributed as a zipped Windows Installer .msi file. You can download the dashboard 

from http://funcube.org.uk/working-documents/funcube-telemetry-dashboard/ as a Windows 

Installer (.msi) file.  Once you have downloaded the installer, please ensure that you right-click on 

the MSI file and select “Properties”.  Ensure that you click on the “Unblock” button if it is displayed. 

The dashboard will install directly to your hard disk and you have the option as to which directory 

the dashboard is placed during the installation. 

To test your station setup, there are seven sample files that can be downloaded and played through 

the Dashboard.  The seven files (one funcubebin recording, two MP3 files and four WAV files) can be 

downloaded from http://funcube.org.uk/working-documents/telemetry-examples/ .  Note that the 

WAV files total about 400MB in size.  

 

Navigating the Dashboard 

To start the dashboard, double click on the “dashboard.exe” programme or select “FUNcube 

Dashboard” from the “Start” menu.   

The first screen you will see is shown in Figure 1. There are eleven separate sets of telemetry data 

displayed on the initial Dashboard screen along with a summary set (“Telemetry Decoding”) which 

gives details on how successful the data decoding is progressing.  The last field to appear is usually 

http://warehouse.funcube.org.uk/
http://data.funcube.org.uk/
http://forum.funcube.org.uk/
http://funcube.org.uk/working-documents/funcube-telemetry-dashboard/
http://funcube.org.uk/working-documents/telemetry-examples/
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the “Power Tracking Mode” field at the bottom of the EPS frame on the right hand side or may be 

the Telemetry Decoding details. This will depend upon your screen resolution etc.  Please ensure you 

resize the Dashboard so that all the data is visible on your screen. 

 

Figure 1 - The FUNcube Dashboard 

 

The initial display shown in Figure 1 is the “RealTime” data. Each box of data represents different 

segments of the telemetry. Do not be concerned by the erroneous numbers that initially appear in 

some fields before any real data has been received. 

The Dashboard is comprised of four main “Panels” which can be sized to suit the user.    The four 

panels are:- 

1. The WOD (Whole Orbit Data)/HR (High Resolution) Data Panel. 

2. The Graphing Panel, and 

3. The Debug/Tuning Panel 

4. The Status Bar 

 

The WOD/HR Data panel is in the upper left of the Dashboard.  This panel is made up of two views 

which are selectable via the “Whole Orbit” and “High Resolution” tabs.  This panel shows the 

different frames of data and clicking on any of the items displays that data in graph form in the 

Graphing Panel. 
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The Graphing Panel is the large panel in the upper half of the Dashboard.  The contents of this panel 

can change depending upon the data you are viewing.  The display in Figure 1 shows all the data 

available from the telemetry but graphs and lists of Fitter messages can also be displayed in this 

panel.  Figure 2 shows an example of a graph being displayed in this panel. 

The Debug/Tuning panel is the large panel occupying the lower portion of the Dashboard.  The 

Debug tab was primarily for the  use of the developers during the development of the telemetry 

system  and allows for the display of the data in hex form as well as internal data from within the 

Dashboard. When a FUNcube Dongle (Pro or Pro+) is connected to the computer running the 

Dashboard, the “Tuning” part of this panel will show a spectrum of approximately 96kHz above the 

centre frequency set on the Dongle. The “AutoTune” toggle enables the system to track Doppler 

shift or not as desired by the user. 

When data is being captured via the soundcard or being replayed via a file, the Tuning panel will 

display a spectrum of the received signal.  The width of the spectrum in this case is 48kHz. 

All of these panels can be resized by placing the mouse pointer over the borders until the mouse 

pointer changes.  Once the Dashboard is arranged to suit your PC display, the configuration can be 

saved by selecting the “Window” menu option, followed by “Save Layout”.  The layout can be 

reloaded by using the “Load Layout” menu option. 

The Status Bar is at the very bottom of the Dashboard window.  It holds status information for the 

current Dashboard session. 

 

Detailed descriptions of the Dashboard follow with all the functionality in menus, panels and the 
status bar described.  
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Dashboard Menus 

 

“File” Menu 

The file menu contains four options. 

 “Open Session” option enables you to reload the data contained in a specific “.funcubebin” 

file. This data will display on the screen exactly as a live session except it can run a little 

faster. 

 “Capture Session” option enables you to record the data already stored in memory from the 

current session to the hard disk.  Files will be saved in the “.funcubebin” format. 

 The “Settings” option allows for the configuration of the Dashboard.  Please see the 

“Configuring the Dashboard” section later in this document for details. 

 “Exit”.  Terminates the program.  Note that this will terminate the Dashboard completely 

and all data in memory will be lost if it has not already been saved. 

 

“Capture” Menu 

The “Capture” menu has five options.  The main purpose of this menu is to select the input that will 

provide the audio to be decoded by the Dashboard. 

 “Capture from Soundcard” - This option will take the input from the soundcard that has 

been selected in the “Settings” panel. 

 “Capture from FUNcube Dongle” – This option will take the input from a FUNcube Dongle 

(Pro or Pro+) that is connected to your computer and has been selected as the input on the 

“Settings” panel.  The dongle MUST be connected before the Dashboard is started.  Once 

selected, the “Tuning” display will start showing a spectrum display of the dongle passband. 

 “Capture from file” - This option will take the input from a file that is selected and load the 

data in a simulated satellite pass.  The time delay between the samples can be varied by the 

time delay option configured in the “Settings”, “Files” option.. [TO BE IMPLEMENTED] 

 “Write Capture data to file” – This option will allow the saving of the currently captured data 

to a “.funcubebin” file.  This file can then be replayed later, when required, using the 

“Capture from file” option. 

 “Clear” – This option erases the current captured data from memory. 
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“Window” Menu 

The “Window” menu has five options. 

 “Load layout” – The Dashboard will start every time in a default layout.  This option allows 

the user to load a Dashboard layout that has previously been saved using the “Save layout” 

option.  [TO BE IMPLEMENTED] 

 “Save layout” – This option saves the current layout of the Dashboard, including the theme, 

position of the main panels and colour scheme. [TO BE IMPLEMENTED] 

 “Themes” – This option allows you to select different themes for the Dashboard.  There are a 

number of alternatives offered as well as an option to revert to the default theme which is 

used every time the Dashboard is started. 

 “Colours” – This option allows you to select from a number of alternative colour options for 

the Dashboard.   

 “Show raw data” – Under normal operation, the raw telemetry numbers are converted to 

show actual values with units of measure.   Selecting this option allows for the raw decoded 

data to be displayed without any additional calculations being carried out. 

 

“Help” Menu 

This menu has only one option which displays details of the Dashboard software, including version 

number and release date.  There is also a link to the FUNcube website (click on the “More Info” link 

at the bottom left of the Help box).  

A future version of the Dashboard will implement a “Check for Update” feature. 

  



 

   Page 7 of 23 

 

Dashboard Panels 

WOD/HR Panel : Whole Orbit tab 

WOD contains specific channels of data, sampled on the spacecraft at one min intervals. These 

telemetry channels can be displayed in graphical form by selecting one of the entries in the list. In 

flight, the spacecraft will store 104 minutes of data. Figure 2 shows an example of some WOD 

displayed as a graph. 

*IMPORTANT* Currently the horizontal time scale is that when the data is displayed by the 

dashboard not when it was actually recorded by the spacecraft. As WOD is only sent in specific 

frames, this can give a distorted view. If you are playing back a recorded .funcubebin file the 

displayed time will be the current time. 

 

Figure 2 - Dashboard displaying graphical data 

 

WOD/HR Panel : High Resolution tab 

These data channels are read every 5 seconds for a minute every alternate minute. Again these can 

be displayed in graphical form. One purpose of having this High Resolution data is to facilitate the 

calculation of the spin rate of the spacecraft. 

Graphical Panel : Fitter Messages tab 
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 A Fitter message is a 200 character text message that can be transmitted from the FUNcube satellite 

as part of the telemetry.  There are a total of nine slots transmitted by the spacecraft and new text 

can be uploaded by Ground Command Stations. It is envisaged that schools wishing to take part in 

the science experiments will design a message for them to receive as part of their experiments with 

FUNcube.  Details of how to submit Fitter message for uploading by Command Stations will be 

released in due course.  

There are some preloaded Fitter messages stored on the spacecraft before launch. Fitter message 9 

can be switched by Ground Command station from normal text to debug data and we anticipate it 

will spend most of its time in debug mode.  

Graphical Panel : Real Time Data tab 

This display shows all the telemetry data on one screen with each type of data contained in separate 

blocks. These channels are read every 5 seconds and display live or, by clicking on the particular title 

header, a graph is displayed. 

Each time you select a particular telemetry channel to plot, the Dashboard will open a new tab in the 

Graphical Panel to display the graph.  Please note, that in its current form, the dashboard can appear 

to freeze, or slow down dramatically, if more than a few graphs are displayed. 

 

Debug/Tuning Panel : Debug tab 

This display allows for the raw hex telemetry to be displayed.  Whilst viewing the hex frames, it is 

possible to copy the last frame, the last 24 frames or all the decoded frames to the clipboard.  The 

data is copied as plain text. 

The debug panel also provides some other displays of data variables that show the settings of some 

of the adjustable parameters that exist within the on board flight software.  More information about 

these will be made available later 

 

Debug/Tuning Panel : Tuning tab 

This is the largest panel at the bottom of the Dashboard and provides a view of the passband when 

the FUNcube Dongle is the primary input source.  There are several functions available via the right-

click option on a mouse and the display can be manipulated/moved around to best suit the 

requirements of the user.  There is also a “Screenshot” option that allows this display to be copied to 

the clipboard or a file. 

To the right of the tuning display, there are a couple of options available to the user.  The “Auto 

Tune” option is available when the input is selected to the FUNcube Dongle.  This will allow the 

Dashboard to track Doppler Shift within the low/high range specified in the “Low” and “High” input 

fields.  The “Monitor Audio” allows for the received audio to be played through the default speakers 

on the PC. 
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Dashboard Status Bar 

The Dashboard Status Bar provides a wealth of information for the user in terms of the telemetry 

being received and decoded.  Status information is provided as follows:- 

The left hand side of Dashboard has four status fields. 

 Spacecraft Name  – This shows from which spacecraft you are receiving data.  The options 

comprise the FUNcube-1 Prototype, Engineering Model (EM), Flight Model (FM) as well as 

the FUNcube-2 Engineering Model (EM) and Flight Model (FM) and is updated automatically 

depending upon the source of thesignals. 

 Frame ID – This lists the id of the frame being decoded and what its contents are. More 

information on the format of the data can be found in the Data Downlink specification 

located in the Downloads section of the FUNcube web site (http://funcube.org.uk ).  

 Sequence ID – Each frame of data transmitted by the spacecraft is tagged with a unique ID.  

This is the Sequence Number. This counts up by one every time a complete sequence of 24 

frames has been transmitted. The last Sequence Number recorded from the Flight Model 

before it was integrated into the ISIPOD was 420. Hopefully we might have some lucky 

listener in the Southern Hemisphere who is able to catch some frames with a sequence 

number of 421!  There will be a special award for any groundstation that is able to upload a 

frame of data to the FUNcube Warehouse with the sequence ID of 421. 

 Received Command – This field lists the type of the most recent command received by the 

spacecraft from the ground as well as showing a Success/Fail status flag for that command. 

The right hand side of Dashboard has five status fields. 

 FUNcube Dongle – If a FUNcube Dongle has been detected as the program starts, it will 

record in this field that a dongle has been found.  If no FUNcube Dongle is present, this field 

will be empty. 

 Capture Status – This indicates the status of the telemetry decode functions.  It is either 

“Capturing” or “Idle”. 

 Packets Decoded/Missed – This field records the number of packets that have been decoded 

in the current session as well as the number that have been missed. 

 Packets Uploaded/Waiting – this field records the number of decoded packets that have 

been uploaded to the Warehouse and the number waiting to be uploaded along with a 

status of the upload operation to the Warehouse.  Note that if the “Settings” option to 

“Stream Data to Warehouse” is not selected, this field will report “Disabled”. 

 Detected Frequency – This field reports the frequency within the passband where signals are 

being decoded. 

It is possible to reset the decoded and missed message counters by right clicking on the Status Bar 

and selecting the appropriate option. 

http://funcube.org.uk/
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Configuring the Dashboard 

To configure the Dashboard for use, there are a number of settings that have to be made. 

These are:- 

1. The Audio Configuration 

2. The Warehouse Connection 

3. Optional Files. 

These settings are access via the “File” menu and the “Settings” option.  Upon selection, a new 

window opens with three tabs labelled “Audio”, “Warehouse” and “Files”.  

 

Audio Configuration 

The FUNcube Dashboard is currently written to decode audio supplied from the FUNcube Dongle 

(both the Pro and Pro+ versions), a Soundcard device or a pre-recorded file. 

“Input Device” – This option lists all the audio devices (soundcards, virtual devices and FUNcube 

Dongles) that are presently connected to your computer.  Select a device as the source for the audio 

input.  Note that if you intend to “Capture from Soundcard”, you should select a real soundcard or 

virtual audio device here.  If you intend to “Capture from FUNcube Dongle”, please ensure that you 

select the FUNcube dongle you intend to use – the Dashboard supports multiple FUNcube Dongles 

connected simultaneously and multiple instances of the Dashboard can be run at the same time.  

 “Output Device” – The Dashboard is able to output the audio that it has decoded and send it to a 

specific audio output device.  This option allows you to select a device other than the default output 

device for your computer. 

“Frequency Preset” - This is an easy method to select the different satellites that the Dashboard has 

been designed to work with and to automatically populate the “FCD Frequency” field.  The 

Dashboard currently works for FUNcube-1 and FUNcube-2, both Engineering and Flight Models (EM 

& FM).   

“FCD Frequency” – This field is automatically populated when the “Frequency Preset” dropdown is 

used or it can be manually populated.  The value selected/entered in this field is used to set the 

centre frequency of the FUNcube Dongle when it is started.  When the Dashboard is set in its normal 

operating mode (i.e. decoding packets), you will then see the spectrum from the Dongle displayed at 

the bottom of the screen in the Tuning Panel.   Note that you may need to adjust your computer 

sound card settings so that a little “noise” is visible at the bottom of the display in the absence of 

any actual incoming signal.  

Once you have made changes to the Audio settings, press the “Save” button to make the changes 

permanent within the Dashboard.  
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Warehouse Configuration 

This tab enables the user to set up their personal login to the FUNcube Warehouse and to control 

the streaming of decoded data to the Warehouse. 

The information needed for this part of the configuration is as supplied in the email sent after your 

registration was completed – it is the information as listed in the “Pre-Requisites” section of this 

document. 

 

Files Configuration 

This tab enables you to select whether or not to produce log files (with a .log extension) and where 

these should be placed. These files contain the data in CSV format and are suitable for use by 

schools for research and investigations.  The last tab on this screen relates to the playback speed for 

the .funcubebin files which were created using the “Capture from File” menu option It is possible to 

adjust the precise speed of playback with this tab. To obtain a realistic speed, i.e. as it was originally 

transmitted by the spacecraft, set the slider to the slowest setting, this will “playback” at one frame 

every 5 seconds. 

  



 

   Page 12 of 23 

Normal Operation of the FUNcube 
Dashboard 

The FUNcube Dashboard is designed to require very little interaction to receive, record and decode 

the telemetry from the FUNcube Satellites. 

The key steps to making the Dashboard operate and decode data are:- 

1. Ensure that the Audio Configuration is setup as described in this document. 

2. If you have registered at the FUNcube Warehouse, select the “Stream to Warehouse” option 

in the Warehouse settings according to whether you wish to submit data to the Warehouse. 

3. From the “Capture” menu, select the “Write capture data to disk” (so you can save the data 

for replay at a later date). 

4. From the “Capture” menu, select the source for your audio. 

5. Sit back and enjoy! 
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Testing your Dashboard Installation 

An important step to ensuring your station is ready to receive the FUNcube telemetry, is to test the 

installation with some sample files or with a FUNcube Dongle. 

Testing with a FUNcube Dongle 

To use the FUNcube Dongle with the Dashboard, there are a few configuration steps that you need 

to complete to confirm correct operation.  These steps differ according to Dongle version and 

Operating System. 

FUNcube Dongle Pro and Windows XP 

Using this combination, simply accept the default settings assigned to the Dongle when you 

connect it to the computer, 

FUNcube Dongle Pro and Windows Vista/7/8 

When a Dongle is first connected to a computer, the FUNcube Dongle Pro is configured as a 

microphone device by the operating system.  It is necessary to alter the default “Recording 

Level” for the Dongle by opening the “Sound” control panel, selecting the “Recording” tab, 

double clicking on the Dongle device, selecting the “Level” tab and altering the volume slider 

so that it reads “1”. 

FUNcube Dongle Pro+ and Windows XP 

Using this combination, simply accept the default settings assigned to the Dongle when you 

connect it to the computer, 

FUNcube Dongle Pro+ and Windows Vista/7/8 

When the Pro+ Dongle is first connected to a computer, the FUNcube Dongle Pro is 

configured as a Line-In device by the operating system.  It is not necessary to alter any of the 

default settings that the operating system assigned to the Pro+ Dongle audio device. 

With the FUNcube Dongle plugged into the computer and with no antenna connected to the Dongle, 

start the Dashboard.  Ensure that the audio settings for the Dashboard are configured so that the 

“Input Device” on the “Settings” page is selected to the Dongle.  On the “Capture” menu, select on 

the “Capture from FUNcube Dongle”.  The Dashboard should look like Figure 3. 
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Figure 3 - Dashboard running with “Capture from FUNcube Dongle” 

Note how the Tuning window now contains a spectrum display that SDR users will be familiar with.  

This indicates that the Dashboard is successfully receiving audio from the Dongle and processing it to 

produce the spectrum display.  If you have a display like this, your Dongle is working correctly and 

you are ready to receive real telemetry from the satellite. 

Testing with pre-recorded WAV Files. 

To test the Dashboard with WAV file, it is necessary to play the .WAV file through a separate piece of 

software and to direct the output of that software to an audio loopback/virtual audio cable type 

connection that can be used in the Dashboard. 

We recommend testing with SDR# ( http://sdrsharp.com ) and the following shows how to configure 

SDR# for use with the Dashboard.  It is however possible to use other software that can play .WAV 

files such as Audacity etc.  

With SDR# installed, start the program.  A window similar to Figure 4 should appear. 

To select a WAV file, use the dropdown box 

at the top of the SDR# window (“Other 

(Sound card)” ) and change the option to “ 

IQ File (*.wav)”.  This will open a file dialog 

box for you to select a .WAV files – we 

suggest using one of the files sample 

telemetry files from the FUNcube website. 

The software should be set to USB and 

both the “Set IQ” and “Swop IQ” tabs 

should be ticked. 

The only other option to change is the 

audio output. If you have an audio 

loopback device, select this, otherwise use 

a software audio loopback device such as 

Virtual Audio Cable. 

Then click on the “PLAY” button. 

Figure 4 - SDR# Initial Screen 

http://sdrsharp.com/
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SDR# will start playing the file and the spectrum and waterfall will start to fill – see Figure 5 as an 

example. 

 

Figure 5 - SDR# replaying a .WAV file 

Start the Dashboard and on the, “File”, “Settings” menu, select the “Input Device” to be the  audio 

loopback device/Virtual Audio Cable and select “Save”.  Finally, on the “Capture” menu item, select 

the “Capture from soundcard” option. The Dashboard will look similar to Figure 6. 

 

Figure 6 - Dashboard displaying signal from a .WAV file 

You should also be able to hear the audio on your system speaker – to verify that, untick the 

“Monitor Audio” check box and the audio should stop.  If it doesn’t, or there is no display in the 

Tuning panel, it would suggest that the loopback device/Virtual Audio Cable is not properly 

configured on your PC.  Please stop the Dashboard, check the settings in the Windows Sound control 

panel and restart the Dashboard.   
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To get the Dashboard decoding the telemetry from the sample WAV file, it is necessary to set the 

SDR# filter to cover the signal in the passband. Figure 7 shows the SDR# filter set to cover the signal 

seen on the spectrum and waterfall displays. 

 

Figure 7 - SDR# filter set to cover telemetry signal 

Once the filter is in the correct location, the telemetry signals will be heard from the Dashboard and 

the Tuning panel will look similar to Figure 8. 

 

Figure 8 - Dashboard showing telemetry signal 



 

   Page 17 of 23 

The Green/Yellow bar in the middle of the Tuning Display will, in all probability, be moving very 

quickly.  This is because the “Auto-Tuning” function is trying to find the correct signal – remember, 

the “Auto-Tune” is also trying to account for the Doppler effect on a received signal.  You can de-

select the “Auto Tune” feature by unticking the check box.   Doing so causes the Green/Yellow 

vertical bar in the Tuning panel to change to a Green/Red vertical bar as shown in Figure 8. 

 

Figure 9 - Manual Tuning in the Tuning Panel 

At the base of the Green/Red vertical marker, there is a small circle with a dot at its centre.  Placing 

your mouse on this circle and left-clicking allows you to drag the Green/Red bar over the portion of 

the signal that you want the demodulator to process.  

Note that the Red (or Yellow if “Auto Tune is active) line marks the centre of the demodulator whilst 

the Green bar indicates the bandwidth of the demodulator itself. 

It is also possible to reduce the frequency range within which the “Auto Tune” will function buy 

setting the “Low” and “High” tuning range.  This can be done manually or graphically. 

To set the range manually, simply enter the lower and upper frequency ranges and the Tuning panel 

will look like Figure 10.  The white area between the two red boundaries now indicates the 

frequency range over which the “Auto Tune” function will function. 

To set the limits graphically, place the mouse in the Tuning panel and, with the left mouse button 

held down, move the mouse slightly to the right.  This will expose a vertical line at the extreme left 

of the signal.  Where the signal intercepts with this vertical line, there is a small circle.  Clicking on 

this circle and moving it to the right increases the lower frequency value for the “Auto Tune” range.  

A similar process on the extreme right hand side of the Tuning panel allows for the upper frequency 

value to be set graphically – see figure 10. 
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Figure 10 - Tuning Panel showing a restricted Auto Tune Range 
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The FUNcube Data Warehouse 

The Data Warehouse enables listeners to upload the data they receive it to a central data 

warehouse. It also enables those without their own receivers to track what is happening, live, on the 

spacecraft. We are hoping that everyone will register at http://warehouse.funcube.org.uk  so that 

the maximum amount of data can be collected from the spacecraft.  

Although we have a few “Whole Orbit Data” channels, it will be very useful, to help the Command 

Team safely manage the spacecraft, if we receive data from all over the world.   

The Data Warehouse will also make it possible for any user to download historical datasets in .csv 

format for educational research.  Details of when this functionality is available will be posted on the 

FUNcube forum. 

  

http://warehouse.funcube.org.uk/
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FAQs 

Can I roll my own software? 

Yes- The FC1 Downlink Specification document and the FC1 telemetry equations spreadsheet are 

available here http://funcube.org.uk/working-documents/. We are very keen to receive and retain as 

much telemetry information as possible so please ensure that you do incorporate this linking to our 

FUNcube Data Warehouse in any software that you create. For further information on this please 

contact G4DPZ “dave at g4dpz.me.uk”. We have plans to make a DLL available which will facilitate 

the production of a different 'front end'. The DLL will contain the decoding algorithms. 

Is this software “open-source”? 

 Yes. It is released under a creative commons share alike non-commercial licence, please see: 

http://creativecommons.org/licenses/by-nc-sa/3.0/ 

The source code will be available shortly on github..watch this space! 

 

 To where do I send comments about this software? 

Bugs in this software can be reported via the open forum at http://forum.funcube.org.uk 

Please use the query facility to ensure your bug hasn't already been raised, and please try to provide 

a detailed description and steps to reproduce the fault. 

There are also three Yahoo groups which, although they have, up to now, mainly concentrated on the 

FUNcube Dongle, will provide new users with valuable advice: 

http://uk.groups.yahoo.com/group/funcube/ This contains a number of user guides and 

troubleshooting guides in the Files section which are recommended reading. We also strongly 

recommend searching the mailing list as it's very likely someone has solved a similar issue before. 

http://uk.groups.yahoo.com/group/FCDevelopment/ 

http://www.funcubedongle.com/  

 

Who do I contact if this software does not load or work properly? 

 See above comments! 

If I see telemetry data that indicates a problem on the spacecraft, who should I contact? 

Email: operations@funcube.org.uk, this will alert the global monitoring and operations team (who 

should already know!) 

Does this software work on linux and Mac OS systems? 

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://forum.funcube.org.uk/
http://uk.groups.yahoo.com/group/funcube/
http://uk.groups.yahoo.com/group/FCDevelopment/
http://www.funcubedongle.com/
mailto:operations@funcube.org.uk
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Not yet, however there are a number of projects in progress to provide decoders for these platforms. 

The FCDevelopment Yahoo group is a good starting place to find them or announce your own work: 

http://uk.groups.yahoo.com/group/FCDevelopment 

Is there an iPad or Android app that does the same job?  

 As above - not yet, but do keep an eye on the FCDevelopment Yahoo group or pitch in and write one 

yourself! 

Will this software work directly with any other type of SDR Dongle? 

Not directly, however we would welcome developers who wish to add support for new hardware. 

Please join the FCDevelopment Yahoo group.  

It is of course possible to use other types of SDRs with the usual types of software such as SDR# or 

SDR-Radio and to use an internal audio loopback device or a software audio device such as Virtual 

Audio Cable etc. 

The example telemetry files are in WAV format – How do I use these?  

 The Dashboard can read and write files in the .funcubebin file format.  To make use of the WAV 

example files, you need to play the WAV files through an audio player (such as MediaPlayer, 

Audacity, VLC etc) and then select the input from the soundcard within the Dashboard software. 

I have multiple FUNcube Dongles connected – How do I identify them in the Dashboard? 

This can be difficult as achieve as the serial number of the Dongle is not used when internally, 

Windows creates configurations for each USB port that a Dongle is connected to.  The best advice we 

can offer is to start with just one dongle plugged into a specific USB port and note that configuration.  

Check it functions with the Dashboard before adding a subsequent dongle. 

I can’t get the Dashboard to work with my FUNcube Dongle or particular soundcard?  

Please double check the settings you have selected in the “Settings” panel for “Input Device” and the 

device you have selected in the “Capture” menu – they MUST be of the same type. That is, if the 

“Input Device” is set to a FUNcube Dongle, then the “Capture” must be set to the FUNcube Dongle.  

Setting the “Input Device” to be a FUNcube Dongle but setting the “Capture” to be from a soundcard 

will give a display in the Tuning panel but it will not be what you are expecting! 

On the “Telemetry Decoding” data shown on the “Real Time” display, what does “Error Count” 

mean? 

Each frame of data transmitted from the spacecraft is 5200 bits with the telemetry data taking up 

2400 bits.  The difference is the extra coding that is applied by the FEC facility at the satellite. 

The “Error Count” displayed on the “Real Time” data represents the number of bit errors detected 

and corrected by the software when decoding each frame of telemetry. 

What sort of antenna will I need to use to receive the data from FC1? 

http://uk.groups.yahoo.com/group/FCDevelopment
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When FC1 is operating in “educational” mode then the telemetry transmitter output power will be 

approx 300mW In this configuration we expect that it will be possible to receive good data with  a 

simple  omni-directional antenna such as a turnstile. When the spacecraft is operating in “amateur” 

mode, the telemetry power will be approx 9dB lower and therefore a steerable antenna with approx 

10dB gain will be required for tlm reception. In amateur mode the transponder will also be active. 

Circular polarisation, and where appropriate, mast head preamps, are recommended. The spacecraft 

will operate in “safe” mode immediately after launch. In this mode the transmitter sends low power 

telemetry only.  

 

Is this the “final” version of the FUNcube dashboard? 

NO – There are a number of attributes and functionality that are still work in progress. These include: 

 Links to Orbitron for location determination and spacecraft pass predictions 

 Links to a support group 

 Change graph scaling to remove erroneous zero readings 

 Making the AFC/AutoTune only track BPSK signals – not just the strongest ones 

 Allow multiple graph displays 

 Enable “control-C “commands to copy screen texts (this already works for the debug screen) 

 Create a Doppler curve graphic at the end of a pass from the detected frequency 
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REVISION DETAILS 

 

Issue Date Description 

Release 1.0 13 November 2013 
Initial Release to support 

Dashboard version 798. 

   

   

   

 

 

 


